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Project 1 Quick Domestic Project

This project is designed to show you how quick it can be to draw plants and hard landscaping 
once you have all the information 
you need. 

Open the file • Project_1.sta  
from the exercise folder. This  
file is a Vectorworks template 
file. It has a scanned image of 
our house plan and the plants 
already imported into it. All we 
have to do is to add the plants 
and hardscape to the plan. 

Go to the • Site Planning Tool set.

Choose the • Place Plant tool.

Go to the • Tool Bar.

Click on the • Plant Tool 
Preferences... button. 

This opens the dialog box where         • 
we choose the plant we want to place.    
You can set the size of the plant, the 
type of plant, spacing and height. 
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Click on the plant, and a series of plants • 
will appear. Choose MeEx.

Click on the • OK Button.

Go to the • Tool Bar.

Choose the first mode. This • 
allows you to place one tree    
at a time.

Click once to place a tree.• 

Your tree is placed        • 
where you clicked.
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Place four plants along      • 
the top of the site. 

Go to the • Tool Bar.

Click on the • Plant           
pop-up menu.

Choose a different plant.• 

Go to the • Tool Bar.

Click on the mode for placing • 
plants in a triangular array.

Click once at the corner of • 
the first plant that we have 
already placed. 
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Come down the boundary.• 

Click once.• 

Move across the                • 
front of the house. 

Click once. • 

Move up the Site.• 

Double click.• 
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Vectorworks draws all the trees.• 

Go to the Site Planning Tool set.• 

Choose the • Hardscape tool.

Go to the • Tool Bar.

Click on the  • 
Preferences... button.

Name the hardscape. • 
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Click on the • Joint Pattern pop-up menu. 

Choose • Pavers-Grid...

Type in the size of the tiles.• 

Type in the angle for the tile grid.• 

Click on the • OK button to leave the                        
Set Joint Pattern Options dialog.. 

Click on the • OK button to leave                            
the Hardscape Object Settings dialog. Sa
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Click once to start the • 
Hardscape.

Move along the                    • 
face of the building.

Click once. • 

Move up the site.• 

Click once. • 
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Move across the site.• 

Click once. • 

Move back to where you started. You • 
will get a screen hint that says Point.

Click once. • 

Vectorworks makes the Hardscape. • 
You can edit the hardscape (or any 
object) with the Object Info Palette. 

Go to the Object Info Palette.• 

Click on the • Hardscape Settings... 
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Click on the • Joint Pattern pop-up menu. 

Choose • Pavers-Grid...

Change the angle to 70º. You may have noticed that       • 
as we drew the hardscape a floating display told you       
the angle you were drawing. 

Click on the • OK button to leave the Set Joint Pattern 
Options dialog.. 

Click on the • OK button to leave the Hardscape Object 
Settings dialog and apply the changes. 

Now you see the new settings • 
applied to the hardscape. 

Go to the Basic tool palette. • 

Double click on the 2D    • 
selection tool. This will            
de-select everything. 

Go to the View Bar.• 

Click on the • Fit to           
Objects button. 
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You should see a worksheet at • 
the top right of the screen. 

Double click on it. • 

This opens the worksheet       • 
in a floating window.

Click on the down-turned • 
arrow at the top left of the 
worksheet window.

Choose • Recalculate...      
from the worksheet menu. 

The worksheet counts up        • 
the trees, and hardscape. 

Close the worksheet by • 
clicking on the close button 
(the red dot on a Macintosh, 
the red cross on Windows)    
on the top of the worksheet 
window.

The worksheet shows           • 
on the drawing. 
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Project 2 Domestic Project

Step 1 Layer and Model Setup

Document Setup

We will set up the file from the beginning, from a blank document. Vectorworks has setting up 
commands to make it easier to set up the file. When you have set up the file it can become a 
template file that you can use to start every new job, saving you a lot of time in setting up...

Go to the Menu Bar.• 

Choose • File > New... 

This opens a dialog box for you                                  • 
to choose Blank Document 

A blank file opens with                • 
a layer scale of 1:1 and             
a letter size page.

We should set up our          • 
page first...
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Go to the•  Menu Bar.

Choose • File > Page Setup...

This opens a dialog box for you to set up the page size.• 

This dialog box allows you to set         • 
up the printer that you are using. 

Click on the • Printer Setup... button.

This dialog box will vary        • 
depending on your printer.

On a Macintosh the dialog box will look           • 
similar to this picture. Set the printer,              
page size and page orientation.

Click on the • OK button.

On a Windows machine the dialog box will         • 
look similar to this picture. Set the printer,         
page size and page orientation.

Click on the • OK button.
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This takes you back to the Page • 
Setup dialog box. 

Our drawings are going to be set     • 
up using Viewports, so the page 
boundary won’t be meaningful on    
our design layers. 

Turn off•  Show Page Boundary.

Turn off • Show Page Breaks.

Click on the • OK button.

Vectorworks shows the new • 
drawing area.

Go to the•  Menu Bar.

Choose • File > Document Settings >  Document 
Setup...

Document Setup  is a quick way to set up the   
drawing when you are starting a new project.
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On this dialog box we get the opportunity to     • 
check the set up of the project as a whole, the 
units, layer scale, drawing area, grid setting        
and the title block size.

Click on the • Drawing Units: Change... button. 
This will open the Units dialog box for us to         
set up the drawing units, primary dimensioning, 
secondary dimensioning and area and           
volume units.

Set your • General Display units 
to the settings that you want. 

Set the • Dimension Objects 
(Primary) to the settings that 
you want. 
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The settings might start                  • 
in feet and inches. 

Set the • Dimension Objects 
(Secondary) to the settings     
that you want. 

Click on the • OK button.

Click on the • Layer Scale: Change... button.         
This will open the Layer Scale dialog box for            
us to set the scale of the current layer.

Set your Layer Scale to • 1:200.

Click on the • OK button.
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Click on the • Drawing Grids: Change... button. 
This will open the Set Grid dialog box for us to     
set the snap and reference grids for our file.

Choose • Grid on the left hand 
side. 

For metric drawings set the • 
snap grid to   100mm  and the 
reference grid to 1000mm .

For for imperial drawings set • 
the snap grid to 4” and the 
reference grid to 3’.

Click on the • OK button.

The reference grid may not appear on the screen due to the density of the grid at a particular 
scale and page size.

The Document Setup dialog box                               
now shows you your settings.

Click on the • OK button.
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Step 2 Layer Setup

Layers allow you to break up the file into manageable chunks. If you are not familiar with 
layers, please refer to the Essential Tutorial Manual, which has a series of exercises to explain 
layers. 

Go to the • View Bar.

Click on the Layers button to open                                         • 
the Organization dialog box.

 

We need to add some layers  • 
for our site plan, planting, and 
boundary line, and we need to 
add a layer for the concept 
drawing.

Click on the • Edit button to edit 
the name of the existing layer. 
We want to change the name  
to something more meaningful.

Change the name of this layer to • planting.

Click on the • OK button. 
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You can see the layer name has • 
been edited. 

To add a layer, click on the • New... 
button.

Name the layer • scan (use this layer                           
to hold the scanned drawing).

Click on the • OK button. 

We need the scanned image at       • 
the bottom of the list. 

Click and drag the scan layer by the • 
# column to the bottom of the list. 

The scan layer should be at the • 
bottom of the stacking order now. 
This means that the plants and hard 
landscaping will sit on top of the 
scanned image. 

Click on the • OK button.

If you haven’t saved your file, save • 
it now.
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Step 3 Importing a Scanned Image

In this project we will import a scanned image. Then we will use the scanned image to add the 
plants and hard landscaping. This is very similar to our first project, but we will go into more 
detail for this project. 

Go to the • Menu Bar.

Choose • File > Import > Import Image File...

Import the • Project 2 scan.jpg file from the         
exercise folder. 

Set your Compression options to • JPEG.

Click on the • OK button. 

The scanned image is about 1:200 • 
scale so we don’t need to do 
anything else to this image. 

Drag the site scan so that it’s in the • 
middle of the drawing. If the scanned 
image is in the center of the drawing, 
leave it there.
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Step 4 Placing and Editing Plants

We will use this to place plants on the drawing. 

Change Layers to • planting (ie. make planting the active layer). 
You can use the Layer button on the View Bar, or you can use 
the Navigation palette. 

Change the Layer Options to • Show/Snap Others. 

Go to the • Site Planning Tool set.

Choose the • Place Plant tool.

The first time you use this tool, a dialog box • 
opens for you to choose the plant. 

Click on the plant image, and a                 • 
series of plants will appear. 

Choose one of the plants. • 

You might not see the same plants as I have  
in this picture. The plants shown are saved in  
a file in the Libraries folder. You can edit this 
file to speed up placing plants. 
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On this dialog box you can change the • 
plant spacing. We want to change the 
plant definition.

Click on the • Edit Definition... button. 

Click on the • Definition tab.

Change the Spread, Height • 
and Spacing. 

Type in the botanical name, • 
the common name and 
anything else you want to 
record about your plant. 

Click on the • Render tab.

This tab allows you to define • 
the rendering options. These 
can dramatically improve the 
appearance of your planting. 
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Click on the • Default Prefs tab.

This tab allows you to set up the • 
spacing, tag display, and so on.     
We will come back to this dialog    
box when we want to edit our     
plants again. 

Click on the • OK button to close     
the dialog box. 

You are back at the Plant Preferences.      • 
This dialog box displays the changes you 
made. You can change the plant spacing       
if you want.

Click on the • OK button. 

Go to the • Tool Bar. 

Choose the first mode. This places • 
one plant at a time.

 

Click once at the top of the site • 
where you want a plant. 
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Vectorworks places the center of      • 
your plant where you clicked. 

If you turned on the tag display you    • 
will be able to see the plant with the    
tag attached.

If you do not like the plant tag where it is, 
you can change it.

Go to the • Basic Tool set. 

Select the • 2D Selection tool.

Move to the blue handle at the corner   • 
of the plant tag. Notice that your cursor 
changes to a double-headed arrow. 

Click once. • 

Move your cursor outside the site.• 

Click once to place the tag. • 

If you want to change the text size of  • 
the tag, use the Format Text command 
from the text menu (just make sure the 
plant object is selected first).
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Go to the Site Planning Tool set.• 

Choose the • Place Plant tool.

Go the Tool bar. • 

Click on the • Preferences... button. 

Click on the • Duplicate... button. 

Click on the • Definition tab.

Type in the botanical name, • 
the common name and 
anything else you want to 
record about your plant. 
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Click on the • Render tab.

This tab allows you to define • 
the rendering options. These 
can dramatically improve the 
appearance of your planting. 

Click on the • Default Prefs tab.

This tab allows you to set up • 
the spacing, tag display, and  
so on. We will come back to 
this dialog box when we want 
to edit our plants again. 

Click on the • OK button. 

You are back at the Plant Preferences. • 
This dialog box displays the changes 
you made. You can change the plant 
spacing if you want.

Click on the • OK button. 
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Go to the Tool Bar.• 

Click on the second mode.      • 
This mode places the plants in     
a group. It places one plant     
each time you click. 

Click once for the first plant. • 

Click once for the second plant. • 

Double click for the last            • 
plant. If you don’t double            
click, Vectorworks will              
keep placing plants. 
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There are the plants. When we look 
at the plants, we can see that they 
do not look like palm trees. We 
should change the 2D shape to 
look more like a palm.

Go to the • Basic Tool set. 

Select the • 2D Selection tool.

Double click on the nikau palm. • 
Double click anywhere on the 
plants. 

This dialog box allows you to edit your plants. • 

Choose • 2D Graphics.

Click on the • OK button. 
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You can see the 2D part of the plant. • 

Zoom in to make it easier to draw. • 

Draw the new plant shape you want. • 

Use polygons, lines and shapes. It is   
better to use closed shapes like polygons. 
That way you can add color or images      
to the shape. You can copy plant shapes 
from other files and paste them here. 
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Click on the • Exit Plant button at the top 
right. 

Your plants are updated. • 

Go to the • Site Planning Tool set.

Choose the • Place Plant tool.

Go the • Tool Bar. 

Click on the • Preferences... button. 

Click on the • Duplicate... button. 
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Click on the • Definition tab.

Type in the botanical name, the • 
common name and any thing 
else you want to record about 
your plant. 

Click on the • Render tab.

This tab allows you to define    • 
the rendering options. These   
can dramatically improve the 
appearance of your planting. 

Click on the • Default Prefs tab.

This tab allows you to set up the • 
spacing, tag display, and so on. 
We will come back to this dialog 
box when we want to edit our 
plants again. 

Click on the • OK button. 
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You are back at the Plant Preferences. • 
This dialog box displays the changes 
you made. You can change the plant 
spacing if you want.

Click on the • OK button. 

Go to the • Tool Bar.

Click on the fourth mode. This mode • 
places plants in a group. It places as 
many plants as possible in an area 
you define.

Click once near the boundary in • 
the back yard. 

Click once near the corner of • 
the boundary.
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Double click to finish. • 

The plants will fill in.• 

If the Plant tag is not where    • 
you want it, you can move it,    
by using the 2D Selection tool. 

Move your cursor to the    • 
handle that controls the        
plant tag position, it’s the   
handle near the text.

When the cursor changes to a • 
reshape cursor, click once.
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Move the mouse to the         • 
new tag location. 

Click once. • 

The Plant tag is moved            • 
to the new location.

So far this is pretty good, but we can also find out how many plants there are. Vectorworks 
has the file we need in the library. To access this file, we need to add it to our Resource 
Browser. This file makes it easy to count the plants. 
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Go to the Resource Browser• 

Click on the Utility Menu button at the top right. • 

Choose • Add New Favorite Files...

Find the • File Plant Lists. It’s stored in you,             
Vectorworks application folder.

On the Macintosh the file is stored in:  • 
Applications/Vectorworks 2009/
Libraries/Defaults/
Reports~Schedules/

On a Windows machine the file is • 
stored in: 
Program Files\Vectorworks 2009\
Libraries\Defaults\
Reports~Schedules\

When the file is added as a favorite, Vectorworks • 
will always link to the file. Generally you won’t 
have to connect to this file again. 

Click on the pop-up menu where you can             • 
see the file name of your current project.

Choose the • Plant Lists file. 
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Click on the • Plant List-Basic worksheet                          
and drag it into the drawing. 

When you release the mouse • 
button, the worksheet is added 
to the file and is placed on the 
drawing. 

Notice that the worksheet has counted up all the plants that you have placed in the • 
drawing. 

Use the • 2D Selection Tool to 
drag the worksheet to a better 
location.

The worksheet is designed to count 
all your plants and collect 
information about the them. If you 
want to know more about using and 
editing worksheets, please refer to 
the Essential Tutorial Manual 
available from http://www.
archoncad.com or 
http://www.Vectorworks.net.
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Step 5 Hardscape

Hardscape is a special tool that makes it easy to draw areas of paving. This hardscape can be 
2D only, or it can be 2D and 3D. If you make it 3D, then it can be a site modifier and can affect 
the site model. 

Zoom in to the south                          • 
area of the house.

Go to the Site Planning Tool Set. • 

Choose the • Hardscape tool. With this tool you draw a shape for 
the hard landscaping, and Vectorworks fills in the hardscape 
using the details that you enter. 

Go to the Tool Bar.• 

Click on the • Hardscape tool Preferences... 
(the last button on the Tool Bar). 

From the • Joint Pattern pop-up menu choose: 
Flagstone...
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This opens a dialog box for you to set the flagstone options, such 
as the overall pattern size and the angle. 

Enter the overall size of the Flagstones, • 1200mm (4’).

Enter the angle, • -19º. This is the angle for the house relative 
to horizontal. 

Click on the • OK button to return to the Hardscape Settings. 

Turn on the • Draw Border option.

Set the Width at • 150mm (6”).

From the • Joint Pattern pop-up menu choose: 
Spaced Joints...

 

This opens a dialog box for you to set the distance between • 
the joints.

Click on the • OK button to get back to the Hardscape Settings. 
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Name the hardscape. Give the hardscape a name • 
you would like to see as a label on the plan. For 
example, you could name the hardscape  Area 1, 
or you could name the hardscape with the type of 
material you intend to use, such as Concrete 
Paving.

Click on the • OK button to close the Hardscape 
Settings. 

Click once for the start of the • 
hardscape. 

Click once for the first corner  • 
for your hard landscaping. 

Click once again for the   • 
second corner for your hard 
landscaping. 
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Click once more for the third corner • 
for your hard landscaping. 

Finally, click once more where you • 
started the hardscape. This should 
complete the polygon.

Vectorworks fills in the hard • 
landscaping. 
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If the hardscape obscures the • 
planting, right mouse click (control- 
click on a one button mouse) on   
the hardscape and choose: 
Send > Send to Back.

The planting looks better with       • 
the hardscape. 

Go to the Object Info Palette.• 

Turn on the tags and change the Hardscape name to • 
something that will be more meaningful for your client. 
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Use the 2D Selection tool to move the • 
Hardscape tag to a better location. 

There is another way to make 
hardscapes. I like this way because I   
find it quicker and easier. 

Use the rectangle tool to draw an • 
area. This technique will show you a 
quick way to make your hardscapes. 

Go to the Menu Bar.• 

Choose • Modify > Convert > Objects from 
Polyline...
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Go to the • Object Type pop-up menu.

Choose • Hardscape.

Select the option to • Delete Source Poly. 

Click on the • OK button. 

The rectangle is converted in to a • 
hardscape. 

This is an easier and quicker way           
to draw hardscape areas. 

Turn on the hardscape tag.• 

Change the hardscape name to • 
something more descriptive. 

Use the 2D Selection tool to move the • 
Hardscape tag to a better location. 
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Step 6 Drawings and Annotation

Drawings without annotation are incomplete. This section shows you how to add a title block.

Standard Title Blocks (Drawing Border)

Go to the • Dims/Notes Tool Set. 

Click once on the • Drawing Border tool.

Go to the • Tool Bar.

Click on the • Preferences... button. 

Click on the Title Block button.• 

Choose the title block: • 
Custom Title Block-01

You can change your title block later • 
to a different one by clicking on the  
Title Block... button on the Object 
Info Palette again. 
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Click on the option for • 
Use As Title Block Only. 
This means that you don’t have turn off the border. 

On the Object Info Palette click  on the • Title 
Block... button. This allows you to choose a 
sample title block to use as the basis of your       
title block. 

Move to the bottom right of the • 
drawing area. 

Double click to place the title • 
block.

With the Object Info Palette you can adjust the scale of         • 
the title block, the contents of the title block and many        
other settings. 

Click on the • Edit Title Block... button on the Object Info 
Palette. 
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Use this dialog box to fill in the details for • 
the Title block.

Fill in the drawing name, drawing number • 
and so on.

Click on the • OK button. 

Notice that the information is • 
added to the drawing border.
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